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Abstract:  
In shipbuilding, the process of forming a flat metal plate into a curved hull plate with a 

compound shape is very important and greatly affects many economic and technical factors 

such as strength, quality, and aesthetics of the hull, construction cost, and time, etc. 

Currently, the forming method of curved hull plates by line heating is used effectively and 

commonly in many shipyards, however, its main problem is very difficult to determine where 

and how much to heat on the flat metal plate to obtain the plate of a certain shape. In this 

paper, a finite element model is established and adjusted based on the actual data to 

numerical simulate the process of forming hull plates by using flame torch line heating. Based 

on this model, the suitable position and temperature for the torch line heating process are 

determined to form a metal plate into a hull plate of a given desired shape. This research was 

applied to form by torch line heating two plates, symbols K1 and K10, located at the bulbous 

bow of a 20,000 DWT cargo ship built at Camranh Shipyard in Vietnam. The test results are 

as expected with displacement deviations between the actual plate surface and the desired 

curved surface in the range of  3%.     
 

Keywords: finite element model, forming method, hull plate, shipbuilding, torch line heating.  

 

 

1. Introduction  
 

A ship’s hull is made up of curved plates welded together, therefore, the process of forming flat metal plates into 

curved hull plates, especially compound doubly curved plates in areas where the hull form has a great change in 

curvature such as bow, stern, bulb bow, etc. is very important and has a great influence on many economic and 

technical factors such as strength, quality, and aesthetics of the hull structures, construction cost and time, etc.    

In shipbuilding, two main methods widely used to form hull plates are mechanical forming and heating forming. 

Mechanical forming is implemented based on a deformation mechanism of material to form the curved plates by 

mechanical forces which are created using the manual method or specialized machines e.g. plate rolling machine. 

This method is usually suitable for forming the hull plates of a simple curved shape, mainly for mass production. 

Heating forming, also known as line heating, is a method of moving a heat source along defined lines, called 

heating lines, to locally heat the metal plate at a specified temperature to form the desired curvature of this plate. 

Three types of heat sources commonly used in line heating are flame torch (oxy-acetylene or oxy-gas torch), 

induction heating, and laser in which line heating by a torch or a set of torches is commonly used in many shipyards 

due to their advantages such as simple and inexpensive equipment, the ability to form doubly curved plates with 

the minimal value of residual stress, making the hull plates with locally thicker, suitable for the automation, etc. 

However, its main disadvantage is very difficult to determine suitable heating parameters such as the heat source 

speed, heat input, position of heating lines, etc. to form a flat metal plate into a plate with an exact desired shape. 

Until now, many studies related to line heating have been performed to find ways to better control this process. 

These studies cover many different research directions, however, they can be grouped into three main topics, 

including: (i) theoretical and experimental studies on line heating, (ii) numerical models to simulate the line 

heating process, and (iii) plan of heating lines.  
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Our review of the studies related to the above three research topics on the forming by line heating gives the 

following observations and conclusions. 
 

(i) Theoretical and experimental studies have been performed by many researchers to study the mechanism of 

line heating, predict the final plate shape based on set either the thermal model, mechanical model, or both. A 

thermal model with heat loss and distributed heat source was first given by Rosenthal et al. (1946) to determine 

an analytic solution of temperature field with a moving heat source by the heat conduction equation. Base on 

this model, some modified models have been proposed to develop and applied for the other problems, e.g. 

Eagar and Tsai (1983) developed a transient model of the temperature field in a semi-infinitive body.  More 

recently, Nguyen et al. (1999) conducted research and proposed the analytical solution for a transient 

temperature of a semi-infinite body subjected to the 3D moving heat sources instead of a heat flux surface. 

The mechanical models are often developed based on beam or plate theory, and known mechanical principles. 

A simplified mechanical model was first proposed by Jang and et al. (1997) aids to predict inherent strain 

zone size and deformations on a heated plate by line heating based on a simple thermal elastoplastic analysis. 

Moshaiov and Vorus (1987) studied the mechanics of the flame bending process, then used a strip model for 

analyzing line heating, but this model was not suitable for the experimental data (Moshaiov and Shin, 1991). 

The combined thermal and mechanical model was developed by Anderson (1999), in which the thermal model 

is used to determine the critical isotherm which defines the strain zone size in the mechanical model. It can be 

seen that, for simplicity, most of the existing analytical models have to be based on very limited assumptions 

so they often predict the deformation of the heated plate either inaccurately, inefficiently, or both. The 

experiments were performed by Masubushi and Luebke (1988), Masubushi and Jones (1999), Kyrsanidi 

(1999), etc. studying the relations between bending angles and heat power, heat source speed, the position of 

heating lines. However, most of these studies are performed for laser forming whose heat source is easier to 

control power and distribution compared to the other heat sources. 

(ii) Numerical models have been developed recently by researchers such as Hsiao et al. (1997), Ji and Wu (1998), 

Yu (2000), Clausen (2000), etc., and have achieved some success in predicting the final heated plate shape.  

However, since the plate forming process by line heating is a couple of nonlinear thermo-mechanical processes 

which makes the complete numerical simulate very difficult, especially when applying on the actual hull plate. 

In addition, most numerical models are usually finite element model which is established based on theoretical 

or experimental formulas for a laser heat source to simulate and compute line heating process.  

(iii) Most studies on determining the suitable location plan for the heating lines are based on differential geometry 

analysis of the forming surface, along with the expansion methods of the curved hull plates (Mitamura, 1961). 

These can be either lines connecting points of extreme curvature on a different surface, which is the difference 

between the initial flat surface and the forming surface (target surface) (Jang and Moon, 1998), or are lines 

passing through points of similar curvature on the forming surface (Shin et al., 1996), or their direction is 

normal to the direction of principal curvature or principal strain with the extreme value of strain of forming 

surface (Ueda et al., 1994, Yu et al., 2000). In our experience, Ueda’s method is probably suitable because the 

direction of the extreme compressive strain is also normal to heating lines. 

Many studies have provided some encouraging results, but most of them are rarely applied in practice because 

most of the finite element models in the existing studies are established only for the plate, and the heating process 

is simulated using theoretical thermal equations which are usually established based on the laser heat source and 

some unrealistic assumptions. In addition, not many studies on the heating line by using the flame torch have been 

applied to form the hull plates because it is difficult to control the deformation of the curved plate and the heating 

parameters so this process must be still carried out manually based on the experiences of the skillful shipbuilders. 

The purpose of this article is to present a new approach for determining the heating parameters suitable for the 

method of line heating using a flame torch to form the flat metal plate in the complex curved plate of the hull. 

This will aid the shipbuilders to determine the most suitable heating parameter, including the position of the 

heating lines on the plate and the input temperature for each line, as well as predict the final shape of the hull 

plates after forming using line heating with a flame torch.  
 

2. Material and Research Method 
 

In this study, a finite element model was established to simulate and compute the line heating process by the 

flame torch in the forming of the actual hull plates of a built ship. The heating parameters including the position 

of the heating lines and the temperature for each line are adjusted based on the actual data to ensure the accuracy 

of this numerical model. The studied results have been applied to form the actual hull plates for validating the 

effectiveness of this new approach. In addition, field research was also carried out in several Vietnamese 
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shipyards to collect the practical data on the line heating by a flame torch and the typical shape of the actual hull 

plate which serves the research purposes of this study as follows. 
 

2.1 The heating conditions  
 

• The speed of heat source speed depends on heat flux, amount of heat, plate thickness, desired curvature, etc. 

With line heating by flame torch, the heat source speed depends on the type of torch and is usually in the 

range V = (4÷7) mm/s, where  V = (6÷7) mm/s for plate thickness (8÷6) mm, V = (4÷5) mm/s for plate 

thickness greater than 16 mm.     
 

• The width of the heating lines depends on many factors such as distance between the torch position and 

plate heating surface, the radius of the heat-affected area, the size and desired curvature of the hull plates. 

The actual statistics show that the heating line width in flame torch line heating is in the range (10 - 20) mm. 
 

• Amount of heat or temperature for each line heating depends mainly on the material of the hull plate. The 

shipbuilding steel plate is mild steel or low carbon steel, so it should only be heated in the temperature range 

(550÷800)oC, so as not to change the mechanical properties of the material. However, some shipbuilding 

steel plates are high strength or high carbon steel, the heating temperature can be increased to about 900oC 

because its melting point is higher. 
 

In addition to the above conditions, the heat source speed and the heating line width depend very much on the 

skill and experience of the shipbuilders to keep a constant distance between the flame core and plate surface 

throughout the heating process. Fig.1 describes the proper position of the flame torch relative to the heating plate 

in practice.   

 
Fig. 1: Proper position of the flame torch relative to the heating plate 

 

2.2 Curved shapes of actual hull plates   
 

The metal plates used in practical production are often divided into singly curved plates and doubly curved plates. 

The singly curved plate has a zero Gaussian curvature at all points on the surface, e.g. a parabole shape, so it can 

be formed by mechanical forming such as pressing, cold-rolling, etc., while the doubly curved plate has non-zero 

Gaussian curvature, e.g. an ellipse or hyperbolic shape, so it is often applied to surfaces with high demands on 

hydrodynamics, esthetics, etc. The actual survey results showed that the hull plates also consist of singly and 

doubly curved plates with actual diverse shapes, and can be classified into curved shapes as shown in Fig. 2. 
 

 
   

(a) Singly curved plate (c) Saddle-shape doubly curved plate 

    

(b) Pillow-shape doubly curved plate (d) Twisted-shape doubly curved plate   

Fig. 2: Typical curved shapes of actual hull plates 
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2.3 Selection of curved plates to study  

In the scope of this study, two typical actual hull plates consisting of a singly curved plate and a doubly curved 

plate which are located on the bulbous bow of a 20,000 DWT cargo ship built at Camranh Shipyard in Vietnam 

in 2017, are selected to study the process of forming using flame torch line heating. Their general type, as shown 

in Fig. 2a and Fig. 2d, is common on the conventional hulls. The actual shapes and locations of these hull plates, 

which are denoted UHU-K#1 (abbreviated as K1) for a doubly curved plate, and UHU-K#10 (abbreviated as K10) 

for a singly curved plate on the hull expansion drawing of this cargo ship’s bulbous bow, are shown in Fig. 3. 

They are developable plates with their planar expansion plate having the same thickness of 10 mm, along with a 

length of 2105.5 mm and minimum width of 1078.4 mm for the K1 plate (see Fig. 4), and length of 1770.1 mm 

and minimum width of 1197.0 mm for K10 (see Fig. 5). Since the typical thickness to width ratio of both plates 

is less than 0.1 the thin plate theory can be applied to them. It also means that the basic assumptions of a thin plate 

can be allowed for these plates as for most other hull plates.   

     

Fig. 3: Hull plate expansion drawing of bulb bow 
 

In this approach, the line heating process to form a plate with a given curvature is performed as follows: 

(i) Develop the computation curved plate and preliminary plan some heating lines on its planar expansion plate. 

(ii) Establish a finite element model of a structure consisting of a planar expansion plate in step (i) linked with 

heating lines to simulate the line heating process for the computation curved plate. 

(iii) Determine the heating parameters suitable for the desired curved plate by determining the displacement of 

the actual curved plate at some specific positions, then adjust the input heating parameters including position 

and temperature of each heating line on the structural model established in step (ii) until the displacement 

values computed by finite element model match actual data at the corresponding positions. 

(iv) Fabrication of a planar expansion plate defined in step (i) and conduct line heating for this plate with the 

heating parameters defined in step (iv), then determine the displacement value of formed curved plate at the 

positions given in step (iii). 

(v) Compare the displacement values of the computation curved plate computed by a finite element model in 

step (iv) and the actual fabrication data in step (v) at the given positions to validate the research results.      
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3. Results and Discussions  

3.1 Develop and preliminary plan of heating lines on the planar expansion plate  
 

Methodically, the curved hull plate can be expanded using known theoretical methods or specialized software.    

In this study, we use Ship Constructor, specialized software for ship structure analysis and is commonly applied 

in many Vietnamese shipyards today, to implement the planar expansion of the K1 and K10 curved hull plates, 

and obtained two planar expansion drawings of these two hull plates as shown in Fig. 4 and Fig. 5, respectively. 

Also, the planar expanded plates exported from Ship Constructor are usually preliminarily marked with the heating 

line plan as shown in these same figures. It is worth mentioning that despite great efforts to form the plates K1 

and K10 according to these suggested heating lines and temperatures, the desired plate shapes were not obtained. 

  

Fig. 4: Planar expansion drawing of K1 plate Fig. 5: Planar expansion drawing of K10 plate 

In the absence of pre-marked heating lines, they can be preliminarily determined as follows:   

• The heating lines are normal to the direction of principal curvature or principal strain of curved plate surface, 

where the principal strain is strain along the principal curvature of the curved surface and can be determined 

based on a known surface theory (Carmo, 1976), Azariadis and Aspragathos, 1997).  

• The heating lines are located towards the principal strain zone and along the centerline of the desired plate 

surface, so symmetry conditions should be utilized in the finite element model to reduce the number of degrees 

of freedom, i.e. reduce computation time. 

3.2. Establish a finite element model to simulate the line heating process 

As stated above, it is not easy to accurately numerical simulate the process of line heating using the flame torch. 

Different from the existing studies where the finite element model is established only for the computational plate, 

while the heating process is described by some theoretical thermal equations which are usually established based 

on the laser heat source and some unrealistic assumptions. This has made it difficult and inflexible to adjust the 

input heat parameters when forming the hull plate using flame torch line heating. In this study, a finite element 

model of computation plates, K1 and K10, linked with heating lines will be established directly in Ansys, a popular 

software for structural analysis by finite element method, to numerical simulation and computation of the forming 

process by line heating with a flame torch. As a result, it is very easy to adjust the position and temperature of the 

heating lines to achieve a given desired curved plate.   

3.2.1. Create a 3D model of computation plate 

Create a 3D model of a planar expanded plate in Ansys is not difficult, but a new ideal and feature in this study is 

the technique of creating a 3D model including a plate linked with heating lines to simulate directly in Ansys the 

line heating process, as follows.  

• Select the problem and solution as follows:  Start Ansys Multiphysics → Enter /Prep 7 on Command Prompt → 

Select structural and thermal problems in the Ansys menu. 

• Select the computational element type as follows: Preprocessor → Element Type → Add/Edit/Delete → Add... 

→ Library of Element Types→ Structural Mass Solid  → 10node 187 → Apply → OK. 

Here, we used the SOLID 187 element because it is well suited to the features of the problem given in this study.  

It is a 3D tetrahedral with 10 nodes, each node has three degrees of freedom with three x, y, z displacements, 

and is well suited to modeling irregular meshes, and has plasticity hyperelasticity, creep, stress stiffening, large 

deflection, and large strain capabilities. More details about this element can be found in the Ansys literature.  
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• Set up material properties for the computational element  

The material of the hull plates is a mild steel plate with mechanical properties at different temperatures are 

determined by comparison of three data sources of Patel (1985), Richter (1973), and Birk-Sorensen (1999). 

Table 1 shows the values of the mechanical properties of the mild steel plate at an initial temperature of 25oC 

required to simulate study plates. 

Table 1: Material properties of mild steel plate at 25oC 

Thermal Conductivity  

(W/m0C) 

Yield stress  
(MPa) 

Young’s modulus  

(GPa) 

Thermal Expansion  

(10-61/oC) 

Poisson’s Ratio 

 

Density  

(kg/m3) 

35 207 200 14 0.3 7850 

The process of setting material properties to the selected element in Ansys is performed by the following steps: 

- Preprocessor → Material Props → Material Models... → Define Material Model Behavior → Structural 

→ Linear → Elastic → Isotropic → Enter values for Young’s modulus (EX) and Poisson’s ratio (PRXY). 

- Define Material Model Behavior → Structural → Nonlinear → Inelastic → Rate Independent → Isotropic 

Hardening Plasticity → Mises Plasticity → Bilinear → Enter a value for Yield Stress. 

- Define Material Model Behavior → Thermal Expansion or Thermal  Conductivity → Isotropic → Enter the 

values for Thermal Expansion (ALPX) and Thermal Conductivity (KXX). 

• Create a 3D model of the planar expanded plates with heating lines. 

Create a 3D model of the planar expanded plates with the given dimensions in Ansys is generally not difficult, 

but the special item here is to model a 3D plate with heating lines to simulate the process of line heating forming. 

The process of creating the 3D geometry model with the heating lines of the K1 plate in Ansys is performed by 

the following steps: 

- Save the file of the K1 plate’s planar expansion drawing exported from ShipConstructor as two separate files, 

including a file of 3D geometry model and a file of heating lines of the K1 plate under the .iges file format, 

e.g. K1_plate.iges and Heating_ line_K1.iges in any graphic software such as Autocad software, to generate 

them into 3D solid objects as shown in Fig. 6 and Fig. 7, respectively.  

  

Fig. 6: Solid geometry model of K1 plate in 

AutoCad 

Fig. 7: Solid heating lines model of K1 plate in 

AutoCad 

- Import the K1 plate model into Ansys software as follows: File → Import→ 

IGES → Select  K1_plate.iges→ Select→ Everything → Oblique View → OK. 

This will display the K1 plate on the screen. 

- Import all heating lines into Ansys as follows: File → Import → IGES… → 

Heating_line_K1.iges → OK → Plot → MultiPlots → Delete all lines and 

surfaces, leaving only lines in the XY plane: 

✓ Preprocessor → Modeling → Delete → Areas Only → Delete Areas Only 

→ Pick all (Fig. 8). 

✓ Preprocessor → Modeling → Delete → Lines Only → Right View → Box 

→ select the lines outside the XY plane→ OK → Front View →  Plot → 

Mutil-Plots.              

  Fig 8: Delete areas only dialog box 
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- Create heating lines on the K1 plate as follows:  

✓ Select → Entities → Selec Entities → click Area, By location, Z Coordinates → Enter 0 for Min, Max 

→ Plot → Area → OK. This will display the K1 plate in the XY plane on the screen as shown in Fig. 9. 

✓ Main Menu → Preprocessor → Modeling → Operate → Booleans → Divide → Area by line → 

Click_Area → OK → Plot → Lines → Divide Area by line →  Loop → Select all heating lines → OK. 

This will display all heating lines on the plate as shown in Fig. 10. 

 

    

Fig. 9: Display K1 plate in the XY plane Fig. 10: Display heating lines on the K1 plate 

3.2.2. Generate the mesh for the plate model  
 

In the forming of the metal plate by line heating, large heat transfer and plastic deformation of the material occurs 

in the area around the heat zone, while the remaining areas on the plate have not large change in temperature and 

deformation so just create a coarser mesh with fewer nodes and elements to reduce and to save computation time. 

This can be done by using the manual mesh tool in Ansys to generate the different mesh for each area on the plate, 

specifically in this case with the K1 plate as follows: Main Menu → Preprocessor → Meshing → MeshTool → 

Click Set button under Global Size Controls → Enter an element length of 20mm → OK → Select Volume with 

Test and Free → Mesh → Pick All → display the uniform mesh over the entire K1 plate as shown in Fig. 11a. 

By doing the same but choosing a smaller element length, a more suitable mesh model is obtained for the K1 

plate as shown in Fig. 11b, where the mesh is thicker in the areas around the heating lines. 

 

 
 

(a) Initial mesh  (b) Mesh after re-meshing    

Fig. 11: Mesh of the K1 plate 
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3.2.3. Establish the mechanical boundary conditions for the plate model 

In this problem, the mechanical boundary conditions of the plate model are set based on the principal strain 

direction of the desired curved surface as follows: 

• The surface of the K1 plate is curved in both the X and Y directions, so its model should be placed on four 

fixed supports to block the horizontal displacements at four corners of the K1 plate (Z = 0) (Fig. 12).  

• The surface of the K10 plate is curved in Y directions, so it must be placed on six fixed supports which are 

evenly spaced along the two edges, and symmetrically across the centerline of the plate as shown in Fig. 13.  

 
 

Fig. 12: Mechanical boundary conditions of the K1 

plate 

Fig. 13: Mechanical boundary conditions of the 

K10 plate 

For the K1 plate, these boundary conditions are set in Ansys as follows:     

✓ Set plate thickness as follows: Select → Entities… → Click Area, By location, Z Coordinates → Enter 10 

for Min, Max → Plot → OK → display K1 plate with thickness t = 10 mm. 

✓ Set the mechanical boundary conditions for K1 plate as follows: Preprocessor → Loads → Define Loads 

→ Apply→ Structural → Displacement → On Keypoints → Apply U, ROT on KPs → Click 4  points at 

4 corners of the plate → OK→ UZ = 0 → OK. 

3.2.4. Determine load models acting on the plate  

The load applied in the forming process by line heating is the heating source along the heating lines on the plate. 

Based on actual collected data as presented above, set heating parameters for the metal plate forming by torch line 

heating, including the heating source speed on all heating lines is 6 mm/s;  the width of all heating lines is 10 mm, 

and the temperature for each line is in the range of (550 - 800)oC corresponds to torch heating (see section 2.1).    

The heat load is set on the plate model in Ansys as follows:  

• Display heating lines on the K1 plate model as follows: Select → Entities → Click Area, By location, and Z 

Coordinates → Enter 0 for Min, Max → Plot → OK  → Front View → OK. This will display the K1 plate 

model with the mechanical boundary conditions (Fig. 14a) and numbered heating lines (Fig. 14b).   

  

(a) K1 plate model with the mechanical boundaries (b) K1 plate model with the numbered heating lines  

Fig. 14: K1 plate model with the mechanical boundary conditions and heating lines plan  
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• Set the heat load as follows: Main Menu → Preprocessor → Loads → Define Loads → Apply → Structural 

→ Temperature → On Areas→ click any heating line, e.g. zero heating line (Fig. 15) → OK → Display 

dialog box for applying the temperature → Apply the corresponding temperature for 0 heating line. 

 

 

Fig. 15: Select zero heating line to apply temperature 

By doing the same, all remaining heating lines are also applied to the corresponding temperature, respectively.  

At this point, our purpose is just to establish a finite element model for simulating the process of the line heating, 

so the position and temperature of each heating line can be preliminarily determined as described in section 3.1.   

In this study, the suggested heating lines exported from Ship Constructor software will be used. As can be seen in 

Fig 4 and Fig. 5, the heating lines exported from Ship Constructor for K1 and K10  plates are evenly spaced on 

either side of the zero heating line which coincides with the plate's symmetry axis. For example with the K1 plate, 

there are 9 heating lines located on either side of the zero heating line linked with its planar expansion plate in 

Ansys and apply the heating parameters according to the data given in Table 2. It means that only heating lines 0, 

2, 4, 6, 8, and 9 with corresponding temperatures are applied in the same way as for the zero heating line above.    

Table 2: Position and temperature of heating lines 

Heating line 0 1 2 3 4 5 6 7 8 9 

Temperature (oC) 700 0 680 0 680 0 680 0 650 650 
 

3.2.5. Solve and output computation results  

Run the solution of the problem as follows: Main Menu→ Solution → Solve → Current LS → Solving → OK. 

After solving, output the computation results as follows: 

• Main Menu → General Postproc → Plot Results → Plot Deformed Shape → Def + undef edge → OK.   

This will display a graph of plate displacement (Fig. 16a). 

• Main Menu → General Postproc → Contour Plot  → Nodal Solu/Element Solu → von Mises stress → OK. 

This will display a graph of equivalent stresses at the nodes (Fig. 16b) and at the elements (Fig. 16c). 

   

(a) Displacement graph (b) Equivalent stress at the nodes (c) Equivalent stress at the elements 

Fig. 16: Graph of displacement and equivalent stress of K1 plate  

To determine the values of strain, displacement, and stress of the plate at any position, e.g. at the position of the 

plate templates (TPL), output the above values at the element nodes as follows:    

• Main Menu → General Postproc → Query Results → Subgrid Solu → Click Stress, X-direction SX → OK 

→ click any point on the plate surface→ OK. 

• Main Menu → General Postproc → List Results → Nodal Solution/Element Solution→ click  Z-Component 

of displacement → print the Z-Component of displacement. 
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3.3. Determine the suitable heating parameters for desired curved plate 
 

After establishing the finite element model of plate linked with heating lines in Ansys, proceed to determine the 

heating parameters of the model suitable for the desired curved plate can be determined as follows: 

(i) Determine the vertical displacements at the midpoint of some cross-sections of the given curved plate. For 

example, the vertical displacements at midpoints of 7 cross-sections (denoted TMPLT) of the K1 plate are 

determined in Autocad or Ship Constructor software as shown in Fig. 17. The dimension of these cross-

sections will also be used to make the templates for fabrication and test the actual curved plate (see Fig. 26).    

(ii) Use the trial and error method to change the heating parameters (position and temperature of the heating lines) 

of the finite element model in the manner described in section 3.2 until the deviations of the vertical 

displacements which are computed by Ansys and determined in step (i) at the corresponding positions of the 

computation plate are within the allowable limit, about 3%, as for common engineering problems in 

shipbuilding. 

 
 

  

  

 

Fig. 17: Displacement at midpoints of the templates of the K1 plate surface 

The number of computation cases more or less depends on the complexity of the computation plate and the 

researcher’s experience in identifying the tendency of displacement of the computation plate according to the 

change of heating parameters. In this study, there are 14 such cases for the K1 plate, and 6 cases for the K10 plate. 

Some specific computation cases for K1 and K10 which are performed as the general case in section 3.3.1 will be 

presented in the following section, where each case will include a table of heating parameters similar to Table 2, 

a comparison table of displacement values, and graphs of the equivalent stresses and displacements of plates.    
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3.3.1. For K1 plate   

• Case 1 

Table 3: Position and temperature of the  heating lines in case 1 for K1 plate 

Heating line 0 1 2 3 4 5 6 7 8 9 

Temperature (oC) 0 0 750 0 700 0 700 0 650 650 

Table 4: Compare vertical displacement values at the template positions of the K1 plate in case 1 

Plate template positions TPL1 TPL2 TPL3 TPL4 TPL5 TPL6 TPL7 

Vertical displacements of actual plate surface (mm) 36.0 41.6 46.9 51.8 56.5 61.5 69.0 

Vertical displacement computed by Ansys (mm) 46.8 57.3 59.6 61.6 67.7 73.8 81.8 

Deviation (%) -30.0 -37.7 -27.1 -18.9 -19.8 -20.0 -18.6 

  
(a) Equivalent stress (b) Displacement 

Fig. 18: Graph of equivalent stress and displacement for case 1 of K1 plate 

• Case 2 

Table 5: Position and temperature of the  heating lines in case 2 for K1 plate 

Heating line 0 1 2 3 4 5 6 7 8 9 

Temperature (oC) 750 0 0 0 700 0 600 0 600 600 

Table 6: Compare vertical displacement values at the template positions of the K1 plate in case 2 

Plate template positions TPL1 TPL2 TPL3 TPL4 TPL5 TPL6 TPL7 

Vertical displacements of actual plate surface (mm) 36.0 41.6 46.9 51.8 56.5 61.5 69.0 

Vertical displacement computed by Ansys (mm) 36.8 44.9 46.2 47.7 53.1 58.4 65.6 

Deviation (%) -2.2 -7.9 1.5 7.9 6.0 5.0 4.9 

  
(a) Equivalent stress (b) Displacement 

Fig. 19: Graph of equivalent stress and displacement for case 2 of K1 plate 
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• Case 3 

Table 7: Position and temperature of the  heating lines in case 3 for K1 plate 

Heating line 0 1 2 3 4 5 6 7 8 9 

Temperature (oC) 0 750 0 0 650 0 600 0 600 600 

Table 8: Compare vertical displacement values at the template positions of the K1 plate in case 3 

Plate template positions TPL1 TPL2 TPL3 TPL4 TPL5 TPL6 TPL7 

Vertical displacements of actual plate surface (mm) 36.0 41.6 46.9 51.8 56.5 61.5 69.0 

Vertical displacement computed by Ansys (mm) 38.8 45.7 47.5 49.4 54.8 60.4 67.4 

Deviation (%) -7.8 -9.9 -1.3 4.6 3.0 1.8 2.3 

  
(a) Equivalent stress (b) Displacement 

Fig. 20: Graph of equivalent stress and displacement for case 3 of K1 plate 

• Case 4 

Table 9: Position and temperature of the heating lines in case 4 for K1 plate 

Heating line 0 1 2 3 4 5 6 7 8 9 

Temperature (oC) 650 0 600 0 0 600 0 600 0 600 

Table 10: Compare vertical displacement values at the template positions of the K1 plate in case 4 

Plate template positions TPL1 TPL2 TPL3 TPL4 TPL5 TPL6 TPL7 

Vertical displacements of actual plate surface (mm) 36.0 41.6 46.9 51.8 56.5 61.5 69.0 

Vertical displacement computed by Ansys (mm) 36.7 42.5 47.5 52.1 56.8 60.8 69.2 

Deviation (%) -1.9 -2.2 -1.3 -0.6 -0.5 1.1 -0.3 

  

(a) Equivalent stress (b) Displacement 

Fig. 21: Graph of equivalent stress and displacement for case 4 of K1 plate 
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3.3.2. For K10 plate  
 

Simulation of the line heating process for the K10 plate in Ansys is done similarly to the K1 plate presented above. 

The difference is in the geometrical boundary conditions and the positions of heating lines as shown in Fig. 13. 

In addition, the displacements at the midpoint of the six template positions of the planar expansion plate are used 

to achieve the suitable heating parameter for forming the K10 curved plate as shown in Fig. 22. 

  

  

 
 

Fig. 22: Displacement at midpoints of the templates of the K10 plate surface 

• Case 1 

Table 11: Position and temperature of the  heating lines in case 1 for K10 plate 

Heating line 0 1 2 3 4 

Temperature (oC) 0 600 0 550 550 

Table 12: Compare vertical displacement values at the template positions of the K10 plate in case 1 

Plate template positions TPL 1  TPL 2 TPL 3 TPL 4 TPL 5 TPL 6 

Vertical displacements of actual plate surface (mm) 52.5 52.0 51.4 51.0 50.7 46.4 

Vertical displacement computed by Ansys (mm) 44.4 46.7 47.6 47.8 47.3 45.1 

Deviation (%) -15.4 -10.2 -7.4 -6.3 -6.7 -2.8 

  
(a) Equivalent stress (b) Displacement 

Fig. 23: Graph of equivalent stress and displacement for case 1 of K10 plate 
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• Case 2 

Table 13: Position and temperature of the  heating lines in case 2 for K10 plate 

Heating line 0 1 2 3 4 

Temperature (oC) 0 650 0 600 600 

Table 14: Compare vertical displacement values at the template positions of the K10 plate in case 1 

Plate template positions TPL 1  TPL 2 TPL 3 TPL 4 TPL 5 TPL 6 

Vertical displacements of actual plate surface (mm) 52.5 52.0 51.4 51.0 50.7 46.4 

Vertical displacement computed by Ansys (mm) 53.5 51.7 50.9 50.7 50.1 46.8 

Deviation (%) 1.9 -0.6 -0.9 -0.6 -1.2 0.9 

 

  
(a) Equivalent stress (b) Displacement 

Fig. 24: Graph of equivalent stress and displacement for case 2 of K10 plate 

3.4. Testing fabrication of the K1 plate  
 

Based on some typical computation cases for the K1 plate above, it can be found that the heating parameters of 

the forming process by line heating corresponding to case 4 for the K1 plate and case 2 for the K10 plate are the 

closest reality. To evaluate the accuracy of the results computed from the simulation model, we formed the K1 

curved plate by line heating with a flame torch according to heating parameters in case 4 at Camranh Shipyard in 

Vietnam. Fabrication of the K1 plate is carried out as follows.  
 

- Locate the position of the heating lines in case 4 on the planar expansion plate of the K1 curved plate in 

preparation for forming this plate by the torch line heating (Fig. 25). 

 
Fig. 25: Determine the position of the heating lines on the planar expansion plate of the K1 curved plate in case 4 

- Mark the position of the heating lines on the planar expansion steel plate of the K1 curved plate according to 
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the dimensions defined in Fig. 25 as shown in Fig. 26a. 

- Use a torch to heat along the marked heating lines in the planar expansion plate with the heating parameters 

as determined in Table 9. The result is a curved plate as shown in Fig. 26b. 

- Fabricate the plate templates at each of their position according to the dimensions specified in Fig. 17 as 

shown in Fig. 26c. 

- Use fabricated templates to verify the shape of the curved surface after forming by the line heating method 

using a flame torch. 
 

  

(a) Mark the heating line on the initial planar plate (b) Shape of the curved K1 plate after forming 

 

(c) Fabricate the templates at the test positions according to their dimensions on the drawing 

  

(d) Verify the transverse curvature of the K1 plate (e) Verify the longitudinal curvature of the K1 plate 

Fig. 26: Testing fabrication of the K1 plate 
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After forming, measure the actual displacement of the formed plate surface at points on the plate templates, with 

20 points are chosen per template, i.e a total of (7x20) points are used to create the actual surface of the K1 plate. 

The measured results show the displacement deviations between the actual surface and the desired plate surface, 

at the template positions are within 3% as shown in Table 15.  

Table 15: A comparison of displacement at plate template positions 

Plate template positions TPL1 TPL2 TPL3 TPL4 TPL5 TPL6 TPL7 

Vertical displacement of the desired plate 

surface (mm) 
36.0 41.6 46.9 51.8 56.5 61.5 69.0 

Vertical displacement of the actual formed 

plate surface (mm) 
35.8 42.8 47 51.5 56 59.7 67.5 

Vertical displacement deviation between 

desired and actual plate surface (%) 
0.6 -2.9 -0.2 0.6 0.9 2.9 2.2 

 

This can also be seen when these two surfaces are superimposed as shown in Fig.27, where the red surface is the 

formed plate surface, the blue surface is the desired surface.   

  

 
Fig. 27: Compare the surface of the formed plate and the desired plate 

 

4. Conclusions 
 

Our study has provided a new approach to effectively solve the complex problem of line heating in shipbuilding. 

The difficulties in determining the heating parameters for the torch forming of hull plates, which have not been 

studied fully in other studies, have been overcome based on a combination of ShipConstructor and Ansys software. 

ShipConstructor aids the expansion of a curved hull plate into a planar plate with a pre-marked heating line plan, 

while Ansys aid to determine the positions and temperature suitable for heating lines by the finite element model. 

In this study, the finite element model is established for the computational structure consisting of the 

computational plate linked with heating lines located on the plate. As a result, it is very easy to apply the flame 

torch forming and adjust the input heating parameters to achieve a desired curved plate. Based on such a 

computation model, the hull plate forming process is solved by the inverse method, that is, the actual curved hull 

plate with the displacement of the desired curved surface has been predetermined, and the heating parameters are 

adjusted to achieve the displacements at some corresponding positions on the plate. Our study has shown that 

doing so makes it easier to find a solution, ensure accuracy, and be applicable in practice. This approach has been 

applied to form other hull plates in some Vietnamese shipyards in the same way because the plates on the bulbous 

bow like the K1 plate are often the most complex curvature of the conventional hulls. By processing the actual 

and computational data obtained in forming various hull plates using our new approach, a solution to the suitable 

heating parameters for the flame torch forming is achieved faster and more accurately. These have brought about 

great economic and technical efficiency by significantly reducing construction cost and time, and improving the 

quality and aesthetics of the hull structure. 
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